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E8000 Link 1/3 USB

 

 

Thank you for purchasing our Passap E8000 Link 1/3 USB (E8L1/3USB) product. 
 
This HTML Help file provides the documentation for the E8000 Link 1/3 product. 
 
The first part of this document provides information about the functionality of the 
E8L1/3USB product. 
You can also find instructions on how to operate E8000 Utility in the first part of this 
document. 
 
The second part of this document provides information about Dialog Manager, the package 
used to develop E8000 Utility, the driver program of the E8L1/3USB product. 
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Functions

 

 

The Passap E8000 Link 1/3 USB (E8L1/3USB) connects a Passap E8000 console with your PC via a USB port. 
 
The following functions are provided by the driver program: 

●     Write a pattern from a file stored on your computer 
●     More than 10 types of files supported including PAT, STP and STC 
●     Show pictures of the selected pattern 

The E8L1/3USB has 2 connectors: an 8 lead rj45 connector to connect to the Passap E8000 console a USB type A connector 
to connect to a USB port on your PC. 
 

 
Two LED indicators are provided to monitor the traffic to and from the Passap E8000: 
1. a red LED indicator that registers traffic from the Passap E8000 to the PC 
2. a green LED indicator that registers traffic from the PC to the Passap E8000 
 
The Passap E8000 Link 1/3 USB can be used as a Screenlink USB by adding a Knitlink Arm. 
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E8000 Utility

 

 

E8000 Utility is the driver program for the Passap E8000 Link 1/3 USB. 
 
You can browse your computer for the pattern you want to knit with your Passap E8000. 
E8000 Utility wil show the pattern selected. 
 
 
DesignaKnit users can, via the IK (Interactive Knitting) option, knit interactive using the 
USB port on your computer. An RS232 port is no longer needed. 
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Starting E8000 Utility

 

 

The Passap E8000 Link 1/3 USB can be operated by E8000 Utility.  
 
Follow these steps to start E8000 Utility: 
1. Press Start 
2. Press Programs 
3. Press Cartridge 
4. Press E8000 Utility 
5. The configuration dialog of E8000 Utility will be displayed 
 

Figure 1
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Configuration

 

 

When E8000 Utility starts you first have to set the com port to which the E8L1/3USB 
hardware is connected. You do this by clicking one of the com ports from the list and then 
pressing OK. 
 

 

 
In case the E8L1/3USB is not connected to the com port specified, you will see the message 
below. 
 

 



 

 
You can show this help file by pressing the Help button. 
 
The File field shows the name of the file last accessed. 
 
You close the E8000 Utility application by pressing the Close button or the cross in the top 
right corner of the dialog box. 
 
If you press OK, the next dialog will be the User Interface dialog. 
 
The Status field shows messages to inform the user of progress or to give instructions. 
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User Interface

 
The User Interface dialog is shown after you selected the com port the E8L1/3USB is 
hooked up to. 
 

 

 
The User Interface dialog has a menu, a number of fields and a number of buttons. 
 
The fields have the following functions: 
Field  Function



 

Pattern

 

The pattern that will be downloaded to the E8000 console when you press the 
Download button. You can populate the pattern field by pressing the ... 
button and selecting a pattern on the browse dialog or you can Drop a pattern 
in the field using Drag and Drop facilities provided by Windows Explorer, 
Pattern Explorer or an other Drag and Drop application.

The picture  Show a picture of the pattern in the Pattern field
Stitches  The number of stitches in the pattern
Rows  The number of rows in the pattern
Method

 

The knitting method. The value of this field is equivalent to the DesignaKnit 
knitting method.  
Values can be: 
 
Value Meaning
0  Fairisle
1  Intarsia
2  2 color Jacquard
3  3 color Jacquard
4  4 color Jacquard
5  5 color Jacquard
6  6 color Jacquard
12  Hand knit
14  Right side facing
15  Wrong side facing
The E8000 console supports method 0, 2, 3 and 4. Method 14 and 15 are 
treated as if they were method 0. 
Method 0 and 2 are essentially the same. E8000 Utility allows you to knit a 
method 0 pattern as 2 color Jacquard and a 2 color Jacquard as Fairisle. 

Status area  Area to display status, progress and error information
 
The buttons have the following functions: 
Button  Function
...  Browse your computer for a pattern to download
Help  Start the online help library
Full  Show full picture of pattern in your internet browser
Print  Make a screen print of the User Interface dialog
Download  Download the pattern in the Pattern field to the E8000 console
Close  Exit from E8000 Utility

 

file:///X|/work/htmlhelp/E8kUtlEn/Topics/full.htm
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Menu

 

 

On the Menu Bar you will find two items: the File Menu and the Help Menu. 
 
File Menu  
Exit to exit E8000 Utility
  
Help Menu  
Contents to display the main help topics
Configuration to set the com port and language
About E8000… to provide information about E8000 Utility
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Browsing

 

 

Various alternatives are available to browse your computer for patterns. E8000 Utility has 
multiple interfaces to accept patterns from: 

●     Browse function on the E8000 dialog 
●     Open With function of Explorer programs like Pattern Explorer, Windows 

Explorer,... 
●     Drag and Drop of drag capable Explorer programs like Pattern Explorer, Windows 

Explorer,... 

 
Click on one of the links above for more information. 
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Browse

 

 

You can browse your computer for one or more patterns. Press the ... button for browsing. 
 

 

 
The dialog above is a standard Windows file open dialog. Please consult your Windows documentation 
for full user instructions. 
 
You see on the left hand side a number of shortcuts to places on your computer where you may have 
stored patterns. On the top (Look in) you see the location where you are currently looking for patterns. 
Use the arrow next to the field to select an other location or alternatively use the up one level button. 
Use the Create New Folder button to create a new folder in the current location. Use the View Menu to 
change the representation of the contents of the Files box. The File name field contains the filter applied 
to the files on the folder. Use the arrow to drop down the list of file you opened earlier. The files of type 
field shows the currently applied filter. Use the arrow to change the filter. 

 



 
You select a file form the displayed list by clicking on it. The file will become blue and you can press 
Open to select the file as the Pattern file. Press Cancel if you want to stop the selection process. 
 
E8000 Utility will support the following file types: 
Extension  Description
PAT  DesignaKnit pattern file
BPT  Brother PaTtern file
BMP  Windows BitMaP file
CST  CompuStrick pattern file
CUT  Passap Creation pattern file
PCX  System 90 INTO SHAPE pattern file
STC  Stitch Painter pattern file
SBR  Stitch Painter brush file
DAT  Silver Reed PC10 pattern file
STP  DesignaKnit pattern file
TXT  Text document
NIT  KnitPad pattern file
PBM  Portable Bit Map file
PGM  Portable Gray Map file
PPM  Portable Pixel Map file
KSW  Knitt Styler pattern file
KSL  Knitt Styler library pattern file
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Drag & Drop

 
Multiple alternatives are available to browse your computer for patterns. Patter Explorer is one of them. Once you found 
the pattern you want to knit, you have multiple options to get it to E8000 Utility. Drag and Drop is one of the options. 
 
When using Drag and Drop, you need to make sure that both the program to drag from (Pattern Explorer in the example 
below) and the drop target (E8000 Utility) are visible at the same time. Actually only the Pattern field of E8000 Utility has 
to be visible. 
You click with the left mouse button on the design you want to use, hold down the left mouse button and start moving 
the mouse in the direction of the Pattern field. You see a shadow of the pattern moving with the mouse. 
 

 

 



 

When the mouse arrives above the E8000 dialog, the mouse cursor looks like a stop sign (which means you cannot 
drop). However, when you move the mouse above the sunken Pattern field box, the mouse cursor changes in a drop cursor. 
 

 

 
Release the left mouse button and the pattern will be dropped in the Pattern field. 
As you can drop any file in the Pattern field, you may drop a file that is not supported by E8000 Utility. You will get an 
error message and you will see: 
 

 



 

 
The filename you dropped is kept in the Pattern field for your reference. 
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Open With

 

 

You can open a pattern with E8000 Utility by right clicking on the pattern. A drop down menu shows up that contains 
Open With and an arrow or Open With ... The difference between the two is that the extension had already file associations 
or didn't have file associations yet. In the example below, bmp files were already opened with E8000 Utility before. Click 
on E8000 Utility and E8000 Utility will be started. 
 

 

 
Once started you will see the Configuration dialog of E8000 Utility. Press OK and the E8000 dialog will show your pattern. 
 
Please consult your Windows documentation for full information about Open With. 
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Full Picture

 
You can get a full picture of the currently selected pattern by pressing the Full button. 
 

 

 
The Full button is normally covered by an icon showing a magnifier glass above a document. 
 
Full picture functionality is particularly useful for lace patterns where only the middle part 
of the design can be shown because lace symbols require a minimum resolution to be 
visible. You can use it for every pattern. Non lace patterns that are wider than 25 stitches or 
longer than 25 rows, will be scaled down to show as much of the pattern as possible. The 



 Full picture shows all stitches in the same size as the lace stitches. 
 
The full picture will be shown in your browser. As a result, you can print the pattern. 
 

 

 
For your documentation: the title of the full picture page in your browser contains the 
filename of the pattern. 
In Internet Explorer, you can set the header to "&w" which will print the filename on the top 
of the page. if you set the footer to "&d&bPage &p of &P", you get page numbering and the 
date on the bottom of the page(s). 
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Print

 

 

Some dialog offer the facility to create a screen print. This can be useful for example if you 
want to remember the options you applied to a pattern during download. 
 

 

 
If you checked Show Print Dialog on the configuration dialog, you will be presented with a 
dialog like the one above. You can select the printer you want to send the screen print to and 
adapt the settings of the printer to your requirements. 
 
Press the Print button to start the screen print. 
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Download

 

 
The download process consists of 2 steps: 
1. programming the E8000 console so it can receive a pattern from the PC 
2. the transfer of the pattern data 
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Program E8000 Console

 

 

After you press the Download button on the main dialog, you will see the Program E8000 
Console dialog.  

 

 
Program the console of your E8000 until you see ON THE PC SELECT "KNIT A 
PATTERN". 
You find instructions on programming the E8000 console in the E8000 Operating Manual 
chapter Programming a pattern sector. 
 

 



 

 
 

Last Modification: March 18, 2014 © 2005,2014 Computerservice SSHS BV. 

mailto:jostimmermans%40compuserve%2ecom


Transfer
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About

 

 

The About dialog of E8000 Utility provides version information. 
 

 

 
You can see above the version of E8000 Utility. 
 
The bottom field displays the version information for your version of Windows. 
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Close
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Create your own pattern

 

 

There are 2 ways to create a pattern: 
- Someone else has created the pattern and produced a diagram of the pattern 
- You have a picture or a photograph which needs digitizing 
 
E8000 Utility accepts Windows BMP files for knitting. E8000 Utility considers every dot in 
the bitmap as a stitch. As a result you can use any graphics program to produce a pattern. 
For relatively small diagrams you can use Microsoft Paint. For pictures and photographs 
you need a sophisticated package like Paint Shop Pro or Photoshop. If you need to enter a 
large diagram, it is easier and faster to scan the diagram and use a sophisticated graphics 
program that can do color reduction and resolution reduction. Both above programs can do 
the job and there are most certainly more packages for this job. 
 
E8000 Utility also accepts text documents (TXT) for knitting. E8000 utility considers every 
character on a line as a stitch. If you adhere to a couple of simple rules, you can enter a 
pattern with any software that can produce files with extension TXT. Microsoft Notepad is 
the simplest of these. 
The plus of text documents is that you can also enter lace patterns. 
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Paint

 
E8000 Utility accepts Windows BMP files for knitting. E8000 Utility considers every dot in 
the bitmap as a stitch.  
Patterns of size 25 by 25 or smaller can be entered without much effort very quickly with 
Microsoft Paint. The Duck25 is done with Microsoft Paint. Here are a few hints to make 
your life easy: 
1. in Image, Attributes set Units to pixels. 
2. in Image, Attributes set Width to the number of stitches. 
3. in Image, Attributes set Height to the number of rows. 
4. in View, Zoom set Zoom to 800% 
5. in View, Zoom set Show Grid 
 
Now you can see the pixels (stitches) and can fill them with the pencil. 
If you copy a diagram from a magazine, you don't have to worry about color information as 
most of them are black and white. If you prefer two different colors, set the background to 
the main color and the pencil color to the contrast color. Don't worry to get the colors wrong 
way around. You can revert them in E8000 Utility with the Negative option or the Exchange 
option. You don't have to worry about right or wrong side facing either as E8000 Utility 
offers the option Reversed. 
 
This also means that lettering is trivial. You can develop the pattern right side facing, where 
you knit it wrong side facing. Just turn on the Reversed option during download. 
 



 

 

 
Above is a diagram done in color in minutes. E8000 Utility will treat the duck above as a 3 
color Jacquard. 
Below is a diagram done in black and white using lettering in Microsoft Paint. 
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Notepad

 
E8000 Utility accepts text documents (TXT) for knitting. E8000 Utility considers every 
character on a line in the text document a stitch. 
Patterns of size 25 by 25 or smaller can be entered without much effort very quickly with 
Microsoft Notepad. The Duck25 is done with Microsoft Notepad. There are 5 basic rules 
you need to adhere to: 

●     The first line contains the word SilverKnit 
●     All lines containing stitches are of equal length 
●     You can use the digits 0 thru 9 to show a color, the first ten in the palette 
●     The characters : ; < = > ? are the last six in the palette 
●     You can add a comment by setting the first character of a line to % (Percent Sign) 

 



 

 

 
Above is a diagram done in color in minutes. E8000 Utility will treat the duck above as a 3 
color Jacquard. 
The contents of the text document is: 
 
SilverKnit 
%Duck25 created with Notepad 
%23456789 123456789 12345 
6666666666666666666666666 
6000000000000000000000006 
6000000000000000000000006 
6000000000000000000000006 
6000000444000000000000006 
6000004444400000000000006 
6000004044400000000004006 
6000444444400000000044006 
6000004444400444444444006 
6000000044444444444444006 

 



6000000044444444440444006 
6000000444444444404440006 
6000000440444444044440006 
6000000444000000444400006 
6000600444444444444000006 
6006000444444444444000006 
6006000044444444440000006 
6000600000000000000000006 
6000060000000000000000006 
6006006666666666666000006 
6000600000000000000000006 
6000066666666600000000006 
6000000000000000000000006 
6000000000000000000000006 
6666666666666666666666666 
 
Hint: you can use a ruler like the comment line above for counting stitches. Multiple 
comment lines are allowed as shown above. 
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Getting Started

 

 

Parts list 

1.  E8L1/3USB 
2.  CD ROM with E8000 Utility software, test program and USB drivers 
3.  Knit Link Arm for interactive knitting with DesignaKnit (optional) 

 
Software Installation 
 
Note: INSTALL THE SOFTWARE BEFORE YOU CONNECT THE E8L1/3USB TO THE 
COMPUTER 
 

1.  Put the USBLinks installation CD in the CD ROM drive 
2.  The USBLinks installation program will start automatically 
3.  When autorun is not enabled on your computer, look for the CD and double-click 

autoplay.exe in the root off the CD 
4.  Follow the instructions on the screen, the InstallShield installation wizard will guide 

you through the process 

Note 1: It is recommended to install E8000 Utility to the suggested folder. 
 
Hardware Installation 
 

1.  Connect the Convex connector of the E8L1/3USB cable to the middle port at the 
backside of your E8000 console 

2.  Connect the A connector of the E8L1/3USB to a free USB port on your computer 
3.  Check the green light to go on and flash one time green/red, and stays off afterwards. 
4.  Windows will indicate "New hardware found" 
5.  Preferably let Windows search for the drivers 
6.  If not found, tell Windows that the drivers are on the CD ROM 
7.  If Windows indicates that the drivers are not compatible, press "Continue anyway" 
8.  The USB Serial Converter is now installed 
9.  Windows will indicate again "New hardware found" 

10.  Preferably let Windows search for the drivers 

 



11.  If not found, tell Windows that the drivers are on the CD ROM 
12.  If Windows indicates that the drivers are not compatible, press "Continue anyway" 
13.  The USB Serial port is now installed 
14.  The installation has finished now 
15.  On some systems a restart is required after the installation of the USB drivers 
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Messages

 

 

Various things can go wrong while running E8000 Utility. E8000 Utility will report errors 
and also other events via message boxes. 
 
You will find screen shots of the messages, an explanation what they mean and where 
possible hints on how to resolve the event. 
 

 

 
Not all pattern types can be downloaded to the E8000 console. Below you find a table with 
pattern types, their numerical value and whether E8000 Utility can download them to the 
E8000 console. 
 
Value Type Downloadable
0 Fairisle Yes
1 Intarsia No
2 2 color Jacquard Yes
3 3 color Jacquard Yes
4 4 color Jacquard Yes
5 5 color Jacquard No
6 6 color Jacquard No
12 Hand Knit No
14 Right Side Facing No
15 Wrong Side Facing No
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Dialog Manager

 

 

Dialog Manager is, as its name suggests, a package that manages dialogs. Dialog Manager 
makes the life of the Windows dialog programmer easier by taking away the boring 
Windows dialog hassle, enabling the programmer to concentrate on user functionality. 
 
Dialog Manager also provides additional functionality on top of the Windows dialog 
functionality. 
The visible additional features used in this application include: 

●     Hatched buttons: a button is dependent on the contents of one or more fields, where 
the fields don't meet the expectations of the button. The user can click a hatched 
button to find out which fields don't meet the expectation of the button. 

●     Field coloring: when a button has the focus, fields on which the button depends are 
colored to show the user that user action is required. 

●     Propagation: when a row in a table is selected, the fields in the row are propagated 
into individual fields. 
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Dialog Manager - Introduction

 

 

A Dialog Manager application presents you with one or more dialogs. 
 
Getting Help For a Dialog. 
 
 
A dialog can contain: 

●     Buttons 
●     Single-line Fields 
●     Multi-line Fields 
●     TableBoxes 
●     TickBoxes 

You can use the mouse or the keyboard to navigate a dialog. 
 
Access Keys 
 
Scroll Bar 
 
Initial Focus and Tab Order 
 
Coloring 
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Dialog Manager - Buttons

 

 

A dialog normally contains an OK button, a Cancel button, and one or more action buttons. 
You can 'press' a button with a mouse click or with the keyboard: 

●     Pressing the Enter key is equivalent to pressing the default button, which is the 
button with a heavy dark border. The default button is the one that has the focus, or, 
if no button has the focus, the one set up as the default. The Dialog Manager makes 
the last button pressed the default. 

●     Pressing the spacebar is equivalent to pressing whichever button has a dotted 
rectangle around its text label. 

●     If a button's label contains an underlined character, pressing the Alt key together with 
that character's key is equivalent to pressing that button. 
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Dialog Manager - Fields

 

 

A single-line field is for display or entry of a character string. When a Dialog first displays, 
a field in which you can enter text is usually empty, but in some cases it contains default text. 
When a field allows you to enter text, you can click to place the cursor within the existing 
text and use the keyboard to edit it. The Home key moves the cursor to the beginning of the 
string, and the End key moves it to the end. The Delete key deletes characters following the 
cursor, and the Backspace key deletes characters before the cursor. 
You can highlight text by dragging the cursor across it. The Delete key deletes highlighted 
text, and typing new text replaces highlighted text. 
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Dialog Manager - Multi Line Fields

 

 

A multi-line field is for display or entry of a character string. When a Dialog first displays, a 
field in which you can enter text is usually empty, but in some cases it contains default text. 
When a field allows you to enter text, you can click to place the cursor within the existing 
text and use the keyboard to edit it. The Home key moves the cursor to the beginning of the 
string, and the End key moves it to the end. The Delete key deletes characters following the 
cursor, and the Backspace key deletes characters before the cursor. 
You can highlight text by dragging the cursor across it. The Delete key deletes highlighted 
text, and typing new text replaces highlighted text.  
Pressing Control+Enter moves the cursor to a new line. 
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Dialog Manager - TableBox

 

 

A TableBox displays a list of items. Scroll through the list using the scroll bar, and select an 
item in one of these ways: 

●     double click on it 
●     click on it and press Enter 
●     use the arrow keys to highlight it, and press the spacebar 

The colour of the table changes on mouse-up (when the focus changes) and on mouse-down 
(when the selection changes). You can deselect a row by pressing the Delete key. 
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Dialog Manager - TickBox

 

 A TickBox is used to enable or disable an option. The option is enabled when an X appears 
in the TickBox and disabled when the TickBox is empty.  
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Dialog Manager - Access Keys

 

 

An access key lets you use the keyboard to activate a single-line field, multi-line field, 
Button, TickBox, or TableBox in a dialog. When a character in the item's label is 
underlined, you can activate the item by pressing Alt together with the key corresponding to 
that character. 
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Dialog Manager - Scrollbar

 

 
A scrollbar appears at the right or bottom edge of a TableBox or multi-line field when its 
contents are not completely visible. Each scroll bar contains two scroll arrows and a scroll 
box that enable you to scroll through the contents of the TableBox or field. 
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Dialog Manager - Initial Focus and Tab Order

 

 

When a control is active, it is said to have the focus, which means that you can act on it. For 
example, if a field has the focus, you can type in it. 
You can use the Tab key to move the focus and activate controls in a dialog. The tab order is 
the order in which controls become active when you use Tab. Using Tab is particularly 
useful and natural for moving from one text field to another. 
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Dialog Manager - Coloring

 

 
Coloring or hatching of fields, tables, or buttons occurs when some action is required before 
a button can be pressed. Read-only fields that are dependent on an unsatisfied button are 
hatched whenever the button is grayed. 
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Dialog Manager - Get Help For a Dialog

 

 

When the Dialog Manager presents you with a dialog, you can get help by pressing F1. This 
displays a dialog where you can choose (when available): 

●     General displays this Help 
●     Forms displays Help for the application 
●     Field displays Help for the field that has the focus 

You can also use the Forms key or Field key to go directly to the corresponding Help. 
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